
Intro 02
When you download and install Xspouse you will have two 
new desktop icons.

One to Xspouse the support calculator
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Intro 03

The other to Xarrears, the companion arrearage calculator.
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Intro 04

When you open Xspouse you will find a menu item to 
“Property”
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Intro 05

When you click on the Property menu item the Property 
screen opens up.

Today I will only talk about the Xspouse support calculator.

To return to that screen, select Support on the Property 
module main menu.

4



01 I presume that most, if not all of you, are either past or 
current DissoMaster uers.

If that is the case, I expect that the main input screen in 
Xspouse looks a little familiar to you.
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02 If you have a look at the printout of the main screen in 
Xspouse, you will immediately see the similarity to 
DissoMaster Report layout
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03 The DissoMaster Report layout is essentially the same 
as that of the Xspouse main screen printout. 
The main difference being that because the “Other taxable 
income” field is expanded in the DissoMaster report, the 
per child information is set in the central column in order to
reduce the number of rows. 
In Xspouse the per chid information is at the bottom of the 
printout.
This similarity is a reflection of the common heritage of 
both programs.
Today I will try to make your transition to using Xspouse 
easier by showing you where in Xspouse you will find 
corresponding DissoMaster features.
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04 If we look at the main screen in DissoMaster, the main 
difference from Xspouse is that DissoMaster has moved to 
the use of Tabs and expandable input fields, whereas 
Xspouse uses Detail input windows and display option 
fields that I will describe In a moment.

8



05 For example, in DissoMaster we expand the “Other 
taxable income” field by pressing the down arrow to access 
details of the other taxable income.
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06 Xspouse on the other hand uses Detail input windows 
instead of expandable input fields.

In Xspouse all of the button like fields have a Detail input 
window associated with them. When the highlight is on one 
of these fields the Detail tool bar button becomes active. 
You can open the associated Detail input window for the 
highlighted field by pressing the Detail button, or you can 
press the “D” key on the keyboard or double left mouse 
button click on the highlighted field.
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07 When we open the Detail input Window for the “Other 
taxable income” field, we see that the input option details 
are very similar to those for DissoMaster.

I don’t think that either the DissoMaster expandable fields 
or Xspouse’s Detail input windows is better than the other, 
it is simply a user preference and what you get used to.
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08 The recessed fields in Xspouse are display option fields. The options are 
arranged in a loop. To move forward through the loop press the space bar when 
highlighting the field or right mouse button click on the field. To move back through 
the loop press the back space key. When you loop through the display at right of 
screen and reach the Data detail view it will initially appear blank. As the label 
suggests, the Data detail view displays the contents of the Detail windows at left of 
screen when they are highlighted. It also allows users to edit the Detail windows via 
this view. 
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09 When you first download Xspouse, one of the first things that you may wish to do 
is to cusotmize the appearance and layout. This is done via the File>Preferences 
menu item. The first item on my list of Preferences to change is to increase the 
Window size to the maximum display size. You can also change the color scheme 
and other display features. 

Once you have selected what preferences you would like, press OK and close the 
program without saving the case file. On restart the new preferences will be active.
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10 Now that we have set up Xspouse to our liking and have 
a basic understanding of how to navigate around the 
program, let’s see where various DissoMaster equivalents 
are found in Xspouse starting with the Children tab in 
DissoMaster.

On this tab you can enter details for children of this 
relationship and that of other relationships. You can also 
manually set whether a particular child qualifies for a 
particular tax credit if ages are not set.

14



11 In Xspouse the child details are entered via the Detail 
input Window for #children or % time with NCP, both of 
which open the same Child Detail input window. 
Before showing you the details in the Children detail 
window, I want to explain several related items on the main 
screen.
I draw your attention to the Asterisk beside the 
#exemptions fields and also lower down on the screen 
beside the Hardship deduction field.
The Asterisk signifies that Xspouse is automatically 
calculating the details associated with these fields based 
on inputs elsewhere in the program that interact with these 
fields.
In the case of number of children if the child ages have not 
been entered via the Detail window this means that all of 
the children are assumed to qualify for all of the child tax 
credits. 
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This behaviour is exactly the same as in DissoMaster.
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12 If all of the children don’t qualify for all of the child tax 
credits and child ages have not been entered, then manual 
adjustment for which child qualifies for which tax credit 
needs to be made in the # exemptions Detail window.
Once you make the change and return to the main screen, 
you will see that the Asterisk has disappeared for the 
parent in whose column the manual change was made.
No asterisk means that automatic calculations have been 
switched off.
If you wish to return to automatic calculation mode, you 
need to highlight the field and press the Asterisk key. 
Doing so undoes any manual changes that were made.
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13 To avoid needing to manually input which child 
qualifies for what tax credit, age data needs to be entered 
in the Detail input window for number of children. I will 
demonstrate this with a simple scenario.
To correctly allocate the child tax credits it is sufficient to 
enter the birth year for each child.
Next let’s have the oldest child being equally shared 
between the parents, but for tax purposes have the father 
as custodial parent.  
To do so we need to toggle the custodial parent to father 
and to enter the time with NCP at 49.99% to indicate 
shared custody.
For the second and third children mother is the custodial 
parent, with the father having the second child for 35% of 
the time and no custodial time with the third child.
Once we have done this and return to the # exemptions 
Detail window we see that the children have been 
correctly allocated to the parents and correctly qualified 
for the child tax credits.
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14 While in the child Detail window I want to show you 
several other features.
Firstly, this is the screen where you input dependent 
children from other relationships. Note that there is no 
input for ages of such children so you will need to make 
appropriate manual adjustments in the #exemptions detail 
window on the main screen for child tax credit 
qualification.
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15 Secondly the # children from other relationships field 
is linked directly to the Hardship deduction detail window 
on the main screen. Entering a child here or on the 
Hardship field automatically enters the child in both fields.
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16 If you don’t want the Hardship deduction as part of the 
support calculations highlight the automatically calculated 
hardship deduction value on the main screen and press the 
Delete button. This resets the automatic Calculate 
FC4071(b) hardship to No and at the same time deletes 
the hardship value in the Detail window and hence the 
main screen. 
DO NOT zero the field by deleting the # of other supporting 
children in the Hardship deduction detail window as this 
will also delete the children from Other Relationships 
from the child Detail window which will result in incorrect 
tax calculations.
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17  The child Detail window also provides several 
options for setting up the timeshare 
arrangements. I don’t have the time to go through 
the details today, but will simply show you what 
is available.

•You can use the Select % for individual children 
or all of the children. As you change the slider to 
change the percentages, you can see how the 
timeshare arrangements changes the support 
payments.
•You can choose to use various common 
arrangements from a Table of various sharing 
arrangements and 
•You can use a Worksheet to give you precise 
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timeshare percentages based on customized 
arrangements.
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18 In DissMaster the next tab across is the Support tab. 

On this tab you can select various Family Code settings 
and spousal support guidelines.
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19 In Xspouse most of the support settings are to be found 
on the Settings screen. 
If a setting is changed from the shipped default a warning 
indicating that it has been changed and is displayed on the 
main screen. In the Settings window the change is 
displayed in RED font to make it easier for users to see 
what has been changed.  
Also note that case relationships such as same sex 
marriage or domestic partnership are found here. 
Remember this as in the current version of Xspouse 
column labels are set by the type of relationship in the 
case.
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20 When you return to the main screen you will notice red 
labels pointing out that the general settings have been 
changed and for federal spousal support a specific label is 
added.

Additionally, you can quickly change the support guideline 
by clicking the labels center screen to change them to 
option fields. 

If one of the User guideline options or the Formula SS is 
selected, input windows for these are on the main tool bar.

The Formula SS option allows customizing the spousal 
support formula by changing the method of adjustment for 
child support and varying the percentages.
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21 Most of these settings can also be accessed via 
keyboard short cuts as can various other features in 
Xspouse.
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22 The next tab in DissoMaster is the taxes tab. 
Here various federal and state taxes and credits are set as 
per the tax codes.
I draw your attention to the federal spousal support 
settings here which can be toggled on and off. This is 
slightly different to the way Xspouse handles these in puts, 
which I will describe in a moment.
The other item that I draw your attention to is the way in 
which DissoMaster handles other Jurisdictions by using an 
adjustment factor to multiply the state taxes This is exactly 
the same as in Xspouse which I will describe in a moment. 
Dissomaster also permits entering a numerical value for 
the other state taxes. When this is done it is not possible to 
use adjusted nets.

26



23 In Xspouse the corresponding tax settings and credits 
are found under taxes on the main menu. 
The settings for federal treatment of spousal support is on 
the setting screen.
Note that the cursor highlight is in the Father’s input 
column in this slide. A number of the sub-menu items open 
up for the parent in whose input column the cursor is in. If 
you find that the menu item is not opening, the reason will 
be due to the cursor not being located in the input column 
for that parent.
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24 Today I will only describe the tax settings menu item and 
leave you to explore the details of the other items on your 
own.
When you open the tax settings you will be presented with 
a list of federal and state taxes that can be toggled between 
INCLUDE/EXCLUDE. 
These toggle fields are actually dual entry fields where you 
can enter a multiplier between 0.0000 and 10.0000. 
The INCLUDE setting is equivalent to the multiplier being 
set to 1 (one) and the EXCLUDE setting is equivalent to the 
multiplier being set to 0 (zero). 
To return to the INCLUDE/EXCLUDE toggle highlight the 
numerical value and press the space bar or right mouse 
button click on the field.
When dealing with out of state taxes the multiplier is 
simply the other state tax rate compared to that of the 
calculated California tax rate. Essentially the same as in 
DissoMaster.
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25 If we now return to the main Settings screen to see how 
Xspouse handles spousal support under the federal tax 
code.
The default settings for all the tax calculations in Xspouse 
are as per the federal and state tax codes. This means that 
you don’t need to take any action in setting up the program 
to comply with the tax codes. It is only when you want the 
program to carry out calculations that require different tax 
treatment to the current code that you need to change any 
settings.
For example, if you have a need to revisit an old case from 
before the Tax Cuts and Jobs Act and wish to include 
spousal support as a tax item federally you need to set 
“Include spousal support after 2018 in federal 
calculations” to YES in the main Settings screen.
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26 If you want to Exclude spousal support from state tax 
calculations as well as federal tax calculations, you need to 
set “Guideline deductible (spousal) support” to EXCLUDE.
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27 The next tab in DissoMaster is the Tactics tab. 
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28 This is essentially identical to that in Xspouse. Both 
programs are set to Tactic 9, to release all dependency 
exemptions, then use the Guideline award. 

Wth the passage of the Tax Cuts and Jobs Act, federally this 
is just a release of child tax credits and additional child tax 
credits.
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29 The effect of releasing exemptions is easily seen in this 
simple example. 
If we view the Proposed field at the bottom of the center
column and toggle the E shortcut key to block and unblock 
the exemption releases we can see the effect by comparing 
the guideline support values to the proposed values.
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30 The DissoMaster Parties tab equivalent is found on the 
Xspouse File>Case information menu item.
Beginning with Xspouse 2025 the names of the parties 
entered here will be used as column headings throughout 
Xspouse.
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31 Currently column headings in Xspouse are set by the 
case data.
In a heterosexual case involving children the column 
headings are Father/Mother
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32 In a heterosexual case not involving children the column 
headings are Husband/Wife
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33 In a same sex marriage, the column headings are Party 
A/Party B
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34 In an RDP case the column headings are Partner 
A/Partner B
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35 These labels propagate to the Property module that you 
access via the Property menu item.

To return to the Support calculator from the Property 
module press Support on the main menu.
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36 The last tab on the DissoMaster new case information is 
the QBID calculator.

40



37 Xspouse has a powerful fully integrated QBID calculator 
on the Detail input window for Qualified Business Income 
Deduction on the main screen.

What I mean by fully integrated is that once the QBID data 
is entered, if there are any changes made to other income 
fields on the main screen, the QBID calculator 
automatically updates the relevant fields and recalculates 
the deduction amount.
You can also toggle the Monthly/Annual input settings from 
within the calculator if required.
You can add PTBs, aggregate PTBs and even disaggregate 
PTBs (if permitted).
There is also an input for patrons of agricultural coops.
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38 Having shown you the QBID calculator, I will also show 
you three other calculators that are found under the Tools 
Menu button.
These are :
a Present value calculator
a Future value calculator and
the Windows calculator.
These calculators are also available on the Tools menu of 
Xarrears, the companion arrearage calculator that is part of 
the Xspouse package download.
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39 With the FV and PV calculators you have the option to 
specify a FV or PV and the calculator will calculate the 
required stream of payments.
Alternatively, you can specify the annuity due value, and 
the calculator will calculate the Present or Future value.
When you open the calculator, all of the row labels on the 
right-hand side are either options or input fields.
First set up the end date.
Note that the valuation date is set automatically if we have 
an asterisk displayed by the date, just like on the main 
screen in Xspouse.
I have left the valuation date the same as the end date in 
this example.
I will specify and interest rate of 10%
You can now choose: 
•the payment frequency by toggling the Payment frequency 
options
•Specify a payment amount and have the FV calculated or
•Specify a FV and have the payment stream calculated.
Note that the calculations update as you type so there is no 
need to press the Enter key after entering a value.
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40 Returning to the Settings screen I will show you how 
Xspouse incorporates the latest Family Code changes. 
Unlike DissoMaster where you have a switch to turn on the 
new FC rules, Xspouse automatically switched to the new 
rules on September 1, 2024.
With the current year being 2025 if you set the program year to 
2024, the calculations will utilise the new FC rules, assuming 
that the time is post September 1, 2024. 
To return to pre-September 1 FC rules when the program year 
is set to 2024, there is a switch in the Settings screen allowing 
you to do so. 
If you are dealing with a case requiring a low-income 
adjustment this switch caters for the period March 1, 2024 
through to August 30, 2024 and utilises the low-income 
adjustment CPI increase from March 1, 2024. 
To return to the January and February, 2024 period, there is a 
further need to switch off the low-income adjustment CPI 
increase for 2024 in the Settings screen. 44



41 Now that we have a quick overview of how to navigate 
around the program I would like to spend a little time 
dicussing the bonus income reports. We frequently get 
questions about how they work and the values generated.
The quick answer to that is that they are no more than 
lookup tables for full guideline recalculation of support 
when the additional bonus income is added to the base 
income displayed on the main screen.
Xspouse has two bonus income reports that are found on 
the Reports menu option:
•a Variable bonus income report and 
•an Annual bonus income report
the Variable bonus income report allows for monthly 
bonuses and to look forward using anticipated bonuses, 
whereas the annual bonus report is more of a look back 
report.
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42 Let’s give Father a base monthly wage/salary income of 
$10,000.
•Next we open up the Variable bonus income report and 
enter a $5,000 bonus for any month and press the replicate 
button
•Then press the browser button to open the bonus income 
report.
•Although you can view the report details within the 
Xspouse table, in the browser the Variable bonus income 
report opens with the bonus row already highlighted and 
you can also select the viewing range.
•In Xspouse the viewing range is selected in the report 
rather than setting the range before generating the report 
as in DissoMaster.
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43 As I mentioned, previously the calculations in the bonus 
tables are simply a full guideline calculation of the total 
income.
In our example if we add $5,000 to the father’s base 
income on the main screen to simulate the bonus we see 
the new support values which are exactly the same as we 
saw in the Bonus table.

47



44(49) Note that like with the Taxes menu items, the Bonus 
income reports open for the party in whose input column 
the cursor highlight is in.
This is more important in relation to the annual bonus 
report as the annual bonus only shows the table for the one 
party. The other party’s bonus can be entered entered at 
top right of the report for two way bonus calculations, but 
no table is displayed for the second party.
With the Variable bonus report this is not an issue as it is 
possible to toggle between both parties’ reports and to 
display tables for both.
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45 I have skipped over a lot of ground today and don’t 
expect that you will remember all of it. I believe that the 
slide notes from this talk are being made available to all 
participants, so hopefully they can provide a bit of a 
memory jogger.
There is a lot that I have not touched on today, but I hope 
that from what you have heard today you will feel a little 
more comfortable in embracing Xspouse.
We are always interested in hearing from users regarding 
what features they would like included in the program. So if 
you find something that you miss when using Xspouse let 
us know and we will try to incorporate it in to an update.
For example we have already been asked for an income 
variation bonus report similar to what DissoMaster has. It is 
something that we will be looking into as an update.
Any other requests, please send them to 
support@xspouse.com
Thank you for having me here today.
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